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Welcome
Welcome to Railbase Professional!, the inventory program for model railroaders that works both
stand-alone and with Ship It! With Railbase Professional and Ship It! you can operate your layout
and maintain your fleet of cars from a single database.

Key Features
-

Store Information and Pictures for Rolling Stock, Passenger Cars, Locomotives, Structures, and Miscellaneous
Items.

- Allows an unlimited number of images per database item.
- Create an Inventory of your Collection for Insurance Purposes.
- Calculate the Correct Weight for Rolling Stock and Passenger Cars
- Store Prototype Pictures and Information- you may have many digital images (along with information) of cars
or structures that you want to build or buy. Store this information in Railbase! Keep in mind that you can store
unlimited pictures of these items. Keep a database of items that you wish to model. Organize your notes and pictures!

- Preventative Maintenance - enter in your inspection items and let your computer keep track of your cars adherence. The database will keep track of when inspection is due, which cars (and which items on that car) pass or fail,
and notify you of “redflagged” cars (triggered when failures pass a threshold which you set). Print blank forms to
fill out “on the bench”.
- Modeling Standards - Develop your own modeling standards and track which of your cars adhere to them. Keep
track of which cars need the grabs or stirrups replaced, or which ones need new wheel sets or couplers.

- Custom Queries - Create and save your own custom queries. Do you want to know which cars in your fleet are
colored boxcar red, are 40 feet long and were placed in service during the 1950’s? Do you want to know which of
your type XM boxcars meet all of your modeling standards?
- Set Modeling Goals and Store Modeling Information: Track which cars you plan to match exact prototypes
and which cars need only be believable representations. Store paragraphs of modeling information for future reference, and then have easy access to this information with custom querying.
- Ideal for clubs and large layouts - you can track ownership of each car (and even their owner’s addresses). The
modeling standards and preventative maintenance features help keep your fleet up-to-date and problem-free.
- Browse, Sort, and Report! Multiple sorts on the major browse screen. Locate any car with ease. Many reports
(choose your sort and perform reports on custom queries).

- Track Car Value, Locomotive DCC Settings and more!
- Import / Export

via comma-delimited files to spreadsheet programs and databases.
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License Agreement
If you do not accept or agree to the terms of this agreement, do not use this product.
Return the package within 30 days for a refund.
This software is protected under federal copyright law. Albion Software retains ownership
of this Software Product. This program is licensed to you under the following terms:
1. You may make copies of this software solely for backup purposes. Duplication of this
Software for any other reason including for sale, loan, rental, or gift is a federal crime.
2. You may use the Software on only one computer at a time. The software may be transferred for use on a different machine; however it must first be removed from the computer on which it was originally installed with the following exception: If the software
is installed on a computer that is used by one individual more than 80% of the time it is
in use, that one individual may also use the software on a portable or home computer.
3. You may permanently transfer the Software and related documentation to another user,
provided you retain no copies and the recipient agrees to the terms of this Agreement

Unauthorized copying of this software or the documentation, or failure to comply with any
of the above restrictions, will result in automatic termination of the license.

V

Limitation of Liability
In no event will Albion Software be liable for any damages, including loss of data, lost profits, cost of cover, or
other indirect, special, incidental, economic, or consequential damages arising out of the use or inability to use
the Software or documentation. This limitation will apply even if Albion Software has been advised of the possibility of such damage. In no case shall Albion Software’s liability exceed the amount paid by you for the software. Some states do not allow the limitation or exclusion liability from incidental or consequential damages, so
the above limitation or exclusion may not apply to you.

Limited Warranty
Albion Software warrants the physical program disk to be free from defects in materials and workmanship. If
within 90 days of purchase the physical program disk is found to be defective, return the disk and we will
replace it at no charge. This product is not warranted in any other way.
The limited warranties stated above are in lieu of all other warranties, oral or written, expressed or implied.
Some states do not allow the limitation or exclusion of implied warranties, so the above exclusion may not
apply to you.
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Minimum System Requirements
l Pentium

class computer

Any version of Microsoft Windows (WIN XP, WIN 95, WIN 98, WIN ME, WIN NT,
WIN2000)

l
l

32 MB RAM, 20 MB Hard Disk Space

l CD-ROM

Drive

l

Mouse

l

Printer supported by Windows (laser or ink-jet preferred)

Installation
Place the CD into your CD-ROM drive, close the drive, and the install program will load after a
short period of time. Please note: I strongly advise using the default setting for the installation
directory. If you must install to another location, make sure the installation directory does not
contain more than 8 characters. It should also have no spaces, and the characters should be alphanumeric.

Backups
Find this functionality under the File pulldown menu.

Backup: This selection will back up the current database directory to the drive of your choice.
For example, if you are in the primary database, and you choose the A: Drive, the files will be
backed up to A:\shipback\primary. These can then be restored using the restore option (see
below). The files are not compressed, so they can also be copied using Explorer.
Restore: This option restores a database backed up using the Backup menu item (above). It
restores to the current database directory, from the similarly named backup up area on the backup
drive. For example, if you backed up to the A: Drive from the primary directory, you can restore
it by: 1. Make sure the correct floppy is in the drive (you must have one that the primary was
backed up to). 2. Make sure you are in the correct database directory (primary, in this case). 3.
Select Restore from the File Menu and enter “A” in the drive letter box. 4. Press Perform Restore.
Note: If you have a large database, it might fill up a floppy. If this happens, error messages will
appear. Doing a Start Fresh (generation menu) will make your database smaller, and possibly
allow it to fit on one floppy. The system will not span 2 floppies. In this case, you will need to
back up to a zip drive, or something similar. You can also backup to your C: drive or another hard
drive. Be wary of backing it up to the same drive as the software is installed on - if the drive goes
down, you’ll be out of luck. Also, if using floppies, it’s best to back up to 2.

Note: All images and pictures must be backed up outside of Railbase. Railbase only stores
the location (path) to each picture or image. The images themselves must be backed up outside of the Railbase program. You may lose these images unless they are backed up outside
of the Railbase program.

Tech Support
There is an email list for Ship It! and Railbase users at groups.yahoo.com. This is the best
place to obtain support. You can communicate with all types of users here, from experts to new
users. The URL is http://groups.yahoo.com/group/shipit
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Introduction
Railbase Professional is a database application. It allows you to store, sort, print,
retrieve, and manipulate data about your
rolling stock, locomotives, and cabin cars.
A database (don’t let these computer terms
fool you) is nothing more than a collection of
highly organized information. An empty database is like an empty library - there’s lots of
shelves, all organized and numbered by a system (the dewey-decimal), just waiting to be
filled with books. Railbase Professional’s
database, likewise is organized by a system
(the one programmed inside it), and likewise
is empty.

detailed information such as number, reporting
mark, AAR type, etc. These pieces of information are called fields. It is good to understand
this because you will be entering a lot of
information into Railbase Professional.
However if you are one of those folks saying
just now, “Don’t give me any of this computer
bull, I’m computer illiterate.”, don’t worry you’ll be able to enter information into the
database without understanding the nuts and
bolts of it.

The database within Railbase is a collection of
related files. There is a file for rolling stock
information, AAR Types, locomotives, Cabin
cars, etc. Within each file however, there are
many groups of information called records.
For example, in the rolling stock file there will
be (after you’ve typed in the data) a record for
each car. Within each car record, there will be

Rolling Stock File
Number Field Rpt. Mark Field AAR Type Field Car Style Field etc.
Record 1 127608

SL-SF

RP

Reefer

Record 2 14550

WAB

XM

Boxcar

Record 3 151276

UP

XM

Boxcar

Etc.

2-2

Introduction..................................................

3-2

3

THE MAIN WINDOW

3-2

Introduction
The main window is your work area for
Railbase Professional. Here you will open up
database windows, and print out reports. The
Menu Bar (see below) contains every function
available. The Title Bar (see below) lets you
see at a glance what database is active.

The row of icons allow you quick entry into
files.

Title Bar

Tells which database is selected

Browse General Items
Browse Structures
Browse Passenger Cars
Browse Caboose
Browse Locomotives
Browse Rolling Stock
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Introduction

The Reverse Button

You will be using two main types of windows
for entering all the information about your
inventory - the browse and update windows.

The reverse button allows you to reverse the
list. In the window shown, if you press
Reverse, car number 127608, currently at the
top of the list, will go to the very bottom of
the list (off-screen). One note: you cannot
search for AAR types - you must build queries
instead, to “filter” the browse window - see
the chapter “Working With Queries”.

What Is A Browse Window?
The picture below shows a typical browse
window. A browse window contains a
scrolling area that allows you to “browse”
through the records of your database. Compare
the file from chapter 2 (page 2-2) with this
browse window. Notice the similarity in information. The browse window is a view into
your database; with it you can examine all the
information you have entered so far. The
browse window is also where you insert,
change, and delete records within your database.

Search:
To quickly locate the record you wish to view,
press the letter or number of the first word in
the leftmost column. For example, in the
screen below you would press the number “2”
if you wanted the highlight bar to jump directly to the first record starting with “2” (car
#220008). If you type more digits, the highlight bar will jump again. For example, if you
type “22005” the highlight bar will jump to
car #220057. The digits you type will appear
in the search window above the browse. This
is useful if the data you want to view has
scrolled off the screen.

VCR Buttons
The funny looking buttons below the last line
of the browse window (just above the insert,
change, and delete buttons) are the VCR buttons. They act just like the buttons on your
VCR or tape player. From left to right their
functions are: Go to the top of the page, Go
back one page, Go back one record. The question mark button brings your cursor into the
search field. When your cursor is in the search
field, you can type the whole number of a car
(in this example), then Tab, and the highlight
bar will move to the car. When your cursor is
not in the search field, and you press numbers
(as described in the last section), the highlight
bar moves according to the latest number in
the box (incremental searching). The next
VCR functions are: Go ahead one record, Go
ahead one page, Go to the end of the file.

Browse Window
4-2
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More Browse Elements
Browse windows contain many functions for
you to use in viewing, sorting, and querying
your data. Experiment with each one to find
out how it will benefit you.
Sort Tabs - each tab provides a different sorting method for the browse.
Selecting a tab resorts the list of cars and provides a different view of the
data. There are ten different sorts.

Display Prototypes, Models, or All
Use to display only Prototype or
Model items or All items. There is a
Prototype Only checkbox for most
database items.

Reverse the Sort Order

Insert, Change, and Delete a car record Doubleclicking also activates Change.
VCR Buttons perform functions similar to a
VCR or Tape Deck. Try them! You can scroll
to the top or bottom of the file, go one page at
a time, or a single record at a time.

Initiate or select a custom query. Also
reset from query to full selection.

Calc. Inspection and Update Standard Button
- updates standard and maintenance records.

Search by the left-most column value (in this case,
Number). Example - pressing 33 will scroll you to a car
beginning with 33. To initiate a specific car search, select
the field and type in the car number. Search field changes
with sort.

Prints the current record.

Standard and Maintenance Buttons - call
up Modeling Standard browse or
Maintenance browse for the highlighted
car.
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What Is An Update Window?
The next picture shows a typical update window. An update window contains entry fields
and/or other window controls such as spin
boxes or radio buttons. The purpose of the
update window is to allow you to enter or
change information in your database records.
When you press the insert button on the
browse window, a blank update window will
appear and wait for you to enter information.
If there is a record highlighted in the browse
window and you press the change button (on
the browse window), the update window will
also appear, but this time it will be filled in
with the current information for that record.
This allows you to change that information.

Tabs

access to the information without being overwhelmed by all of it. you can fill out as many
or as few tabs, or fields in the tabs, as you
wish.
Save To Buffer, Retrieve From Buffer
Press the Save button to store all of the current
cars information. Then when filling out a similar car, press the Retrieve button. Now all of
the new car’s fields are filled out for you.

Rapid Entry
Most of the update forms in Railbase
Professional use rapid-entry. This means that
when you press OK after inserting a record,
the update form stays on-screen, ready for you
to add another entry.

There are many tabs in the example below.
Each tab contains different fields, organized
by the title of the tab. This allows you easy

Update Window
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Drop-Down Entry Lists
Many of the update forms will contain dropdown entry lists. These have a downward
pointing arrow on their right-hand side (see
the picture to the right). The Vendor,
Manufacturer, Construction, Scale, and
Coupler Type fields are all of this style. The
advantage to these is that you can build your
own selection lists, both on the fly and from
the Lookup Menu.
The next picture to the right displays the Scale
drop-down entry list. The user has just pressed
the arrow button to the right of the entry field,
and the items in the scale list have appeared.
You can either choose from the existing items,
or type a new item into the entry field. The
new entry is then added to the list, so that you
can select it next time. If you know the entry
is not on the list to start, you can just type the
entry directly in without pressing the arrow
button.
The Lookup Menu is displayed to the right.
From this menu, the Lookup lists can be edited (add, change, delete records) stand-alone.
The Lookup browse windows feature in-line
editing. This means that there are no update
windows for these browses. You edit the information directly on the browse screen. When
you press Insert, a line opens up in the
browse with an active cursor. You can do
rapid-entry by just pressing Tab or Enter after
each entry. To exit rapid-entry mode when
performing in-line editing, you must press
ESC. You need to do this before you can
close the window.
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AAR Types, Industries, Road
Names
These files are found under the Main menu.
They perform similar functions as lookups, but
have update forms. When you enter the AAR
Type field in the Rolling Stock Browse, a
browse select window of AAR Types appears.
This is the same browse that appears when
you select AAR Types under the Main menu.
You can use these browse windows to enter
your data before entering cars, locomotives,
and caboose information. See pages 7 & 8,
this chapter, for an explanation of how these
files work.
These browse windows and update forms are
very similar to their counterparts in Ship It! If
you are a Ship It! user, make sure the Ship It!
User checkbox is checked in the Options tab
under the Options selection in the File menu.
This will enable all of the fields on these
update forms. If you are not a Ship It! user,
there are items on these update forms that do
not pertain to you. Therefore, they are greyed
out - you do not need to enter information
here. You can, however, if you wish.

Bypassing The Mouse
The following keys will allow you to insert
and delete records, plus hop from field to
field, all without the use of the mouse:

The Insert Key
Similar to pressing the insert button.

The Delete Key
Similar to pressing the delete button.

Tab
Advances to the next entry field or control

Shift-Tab
Goes back to the previous field or control

Enter
Similar to pressing the OK button.

Esc
Similar to pressing the cancel button.

Page Up
Scrolls browse list one “page” up.

Page Down
Scrolls browse list one “page” down.

Ctrl-Page Up
Scrolls browse list to top.

Ctrl-Page Down
Scrolls browse list to bottom.
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Building Your Database
Related Files Explained
Many of the files in Railbase Professional are
related. This keeps you from having to type
the same information over and over again
when filling out the database. For example,
each car can have an AAR type and car style
associated with it. Compare the update windows below. Notice the AAR type and the Car
Style appears in each. This data did not have

to be typed in twice. When you click on the
AAR field in the update rolling stock window,
the AAR type browse window will appear,
allowing you to select an AAR type. The Car
Style field in the rolling stock update window
is a read-only field filled in from the AAR
Type File.
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Which Files Should I Enter Data In
First?
Data can be entered in the database “on the
fly”, that is, at the point it is required.
However, for the beginning user it is better to
have the data already entered. Then, when you
are comfortable with the software, you can try
entering data “on the fly”.

Entering Data On The Fly
Entering data on the fly is used when you need
to select an item from a browse window, but
the item has not been entered yet. Let’s say
you are entering the record for a new car, and
you have entered the AAR Type field. The
AAR Type browse window appears, allowing

4-8

you to select tan AAR Type. The following
picture shows the AAR Type browse window
asking for the user to select an AAR Type. At
this point, if you do not see the AAR Type
you need, it can be entered via the insert button. The insert, delete, and change buttons
here perform the identical functions as in a
normal browse window.

Introduction
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The File menu allows you to call up the Options
menu and Exit the program. The Options menu provides
some choices for you to make on how to configure Railbase
Professional! Backup and Restore provides functionality for
you to backup and restore your database (data only, not pictures). For instructions on how to backup and restore your
database, see page IX. Import and Export allow you to import
and export (see the Import/Export chapter). Exit allows you
to leave the program.
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Introduction
The option window is where you set all your preferences, or options, in Railbase Professional.

Database Tab
There are four databases available to you within
Railbase. These are derived from Ship It! You can
use these to maintain four separate collections, if
you wish.

Options Tab
Check the “Ship It! User” box if you own Ship It!.
This will enable the “Ship It! menu in the main
menu area. This allows you to access other Ship It!
files from Railbase Professional. These files are
found under the Ship It! menu. It also enables some
of the other Ship It! features (such as “Available”).
When you uncheck the box marked “Available”, the
car is removed from the Ship It! session database
(removes it from the layout).
“Flag Car at this Number of Failures” enables the
“Red Flag” feature of Railbase. If a maintenance
item fails inspection this number of times, the car is
“Red-Flagged”, indicating that a serious look needs
to be taken at this car.
The “Calculate Car Inspections On Start-Up”
checkbox, when checked, will cause the program to
initiate the same procedures as the “Calculate
Inspection” box and the Update Standards box in
the main browse windows, except on start-up. This

updates each database with the current maintenance and standard items and calculates the
inspection dates for all the items.
The Legacy checkbox should only be checked
when you are a pre-2.0 user of Railbase and do not
wish to reselect your images. This checkbox, when
checked, allows you to keep using your images as
you did before, except that you can now have one
additional image (for a total of two per database
item). In order to get the new unlimited image
functionality, you will have to uncheck this box
and reselect all of your images
A new user of Railbase 2.0 should never have this
box checked, as it will limit them to only 2 images
per database item. This checkbox exists solely for
the use of pre-2.0 Railbase users.

Image Paths Tab
See page 9-2 for an explanation of image paths.
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Import / Export
The import and export options are found in the
File pull-down menu. The options allow you
to both import data into Railbase Professional
and export data. Both import and export work
with comma-delimited files. Comma-delimited
files are commonly imported and exported to
and from many commercial spreadsheet and
database programs.

The format of a comma-delimited file is simple - it is an ascii (text) file with one record
per line. Each field is separated by commas on
these lines. Text (string) data is enclosed in
double quotes. Numeric data is not enclosed in
quotes. A sample import file called
“import.csv” is in the shipit directory.

1

4

2
3

Fields

Note:

1 Import File Name Use the look up button
(item 4) or type in the name of the file. The file
must end with a “.csv” extension.

1. Import File appends records - you can
import records into an already established database.

2 Car Caboose Locomotive Choose which

2. The Export File window is similar to the

database you wish to import to.

3 Import File Click on this button when you
are ready to import the file.

4 Lookup File Button Click on this button to
bring up a file selection window for the import
file name field.

Import File window except there is no lookup
button.

3. When importing currency values, do not use
any dollar signs ($), or the value will not be
accepted.

3. The field descriptions on the next page(s)
match the text for each field in the appropriate
update window. If you are uncertain of the
meaning, look in the update screen and find it
there.
4. Passenger Cars are imported / exported automatically with Cars. Only the common fields
that they share are imported or exported.
5. Structures and General Items cannot be
imported or exported at this time.
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File Formats:

Caboose (both import & export)

Note: Number in brackets indicates text length
or numeric value choices

Type
Number
Reporting Marks
Notes
Home Yard
Manufacturer Type
User 1
User 2
User 3
User 4
Vendor
Manufacturer(model)
Description
Part Number
Construction
Scale
Car Manufacturer
Car Length
Truck Type
Coupler Type (model)
Color
Original Cost
Current Value
Owner

Car (both import & export)
AAR Type
Number
Reporting Marks
Notes
Available
Home Yard
Manufacturer Type
User 1
User 2
User 3
User 4
Vendor
Manufacturer(model)
Description
Part Number
Construction
Scale
Car Manufacturer
Car Length
Truck Type
Coupler Type (model)
Color
Original Cost
Current Value
Owner

text(5)
text(15)
text(7)
text(60)
numeric (1 or 0)
text(30)
text(30)
text(20)
text(20)
text(40)
text(40)
text(30)
text(30)
text(60)
text(30)
text(20)
text(5)
text(30)
text(20)
text(30)
text(30)
text(30)
text(10)
text(10)
text(30)

text(20)
text(15)
text(7)
text(60)
text(30)
text(30)
text(20)
text(20)
text(40)
text(40)
text(30)
text(30)
text(60)
text(30)
text(20)
text(5)
text(30)
text(20)
text(30)
text(30)
text(30)
text(10)
text(10)
text(30)
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Locomotive (import)

Locomotive (export)

Number
Reporting Marks
Notes
Available
Home Yard
Manufacturer Type
Classification
User 1
User 2
User 3
User 4
Vendor
Manufacturer(model)
Description
Part Number
Construction
Scale
Loco Manufacturer
Length
Coupler Type (model)
Color
Original Cost
Current Value
Owner

Number
Reporting Marks
Notes
Available
Home Yard
Manufacturer Type
Classification
Type
Duty
User 1
User 2
User 3
User 4
Vendor
Manufacturer(model)
Description
Part Number
Construction
Scale
Loco Manufacturer
Length
Coupler Type (model)
Color
Original Cost
Current Value
Owner
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text(15)
text(7)
text(60)
numeric (1 or 0)
text(30)
text(30)
text(30)
text(20)
text(20)
text(40)
text(40)
text(30)
text(30)
text(60)
text(30)
text(20)
text(5)
text(30)
text(20)
text(30)
text(30)
text(10)
text(10)
text(30)

text(15)
text(7)
text(60)
numeric (1 or 0)
text(30)
text(30)
text(30)
text(12)
text(12)
text(20)
text(20)
text(40)
text(40)
text(30)
text(30)
text(60)
text(30)
text(20)
text(5)
text(30)
text(20)
text(30)
text(30)
text(10)
text(10)
text(30)
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Setting Up Standards
The first order of business in setting up standards for your models is to decide what standards you wish to implement and to what level
you wish to implement them. The picture to
the right displays the “Standards” Tab from
the Rolling Stock Update form. The Status line
gives the current standard status of this
model. The “Modeling Goal” section lets you
choose your goal for this model.
The modeling goal choices are based on an article I read by Jim Six in the March, 1995 issue of
Model Railroading, titled “Train Fillers”, which really influenced my thoughts on freight car
modeling. His main point (as I saw it) was that most of us don’t have enough time to model each
car to the exact prototype. In order to have enough time to build a fleet of cars to operate a
model railroad (if that’s what you want to do), we can compromise by building many cars that
match the “Believable Representation” category, while modeling fewer “Matches Exact
Prototype” cars. This still gives us great-looking trains while allowing us to complete a fleet.
You don’t need to fill out the Modeling Goal. It is there only for you to be able to track your
modeling efforts more easily (there will be a report that will graphically display the percentages
of modeling goals). As far as setting up standards goes, you can use modeling goals or not, it
will make no difference to the program.

Generic Standards
The next thing you need to set up is your generic standards. You will find these in the Generic
Menu. The purpose of generic standards is to allow you to set up a number of standards by
which all of your inventory items are judged.

1
2
3
4
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Fields
1 Text Main text stating the standard.
2 N/A (Not Applicable) When this box is
checked, the standard record being added to
the inventory item will have its N/A box
checked. This means that the standard does not
apply to the car, caboose, or locomotive. You
would check this box only for a standard that
you want to affect only a minority of
cars/locos/cabin cars. This way, when a record
is added to your inventory, this standard will
not affect it until you uncheck the box (on the
inventory item’s standard update form).
Simply put, any item with the box checked
here will by default start out not applied to an
inventory item.

3 Apply to Cars, Locomotives, Caboose If a
box is checked here it means that the standard
will apply to the inventory type (car, locomotive, caboose). If the box is not checked, the
standard item will not show up in the inventory item’s browse window. The difference
between these checkboxes and the N/A checkbox (item 2) is that unless these boxes are
checked, the standard will not show up at all.
In the case of N/A, the item shows up , but it
is described as not applying - with N/A you
have a choice as to make it apply or not from
the inventory item’s standard update form.

4 Notes - This is an optional notes area for
more fully describing the standard being
implemented.

Entering Generic Standards

The Standards Browse

1. Enter the text for the standard in field number 1 above.

Each category (rolling stock, locomotives,
cabin cars) has their own standards records.
To see these records, you can click on the
Standards button that appears on each main
browse window. This activates the standards
browse for the current (highlighted) inventory
item.

2. Check the N/A (Not Applicable) box if you
wish.
3. Check the category(s) you wish to have this
standard apply to (cars, locos, cabin cars, or
any combination, including all).
4. Use the notes field to describe techniques
used or list the parts needed to “meet” the
standard.
Do this for all of the standards you wish to
implement. If you have certain standards you
wish to apply only to those cars whose modeling goal is “Matches Exact Car”, check the
N/A box. Then you can go into the Standards
Update window for that car/loco/caboose and
uncheck the N/A box. You have just implemented a standard that affects only that car!.

When the standards browse is entered, the
records for that item are updated. For example, if you had just added a new standard to
the generic standard file, this new standard (if
the matching category box had been checked)
would be added. Likewise if you delete a
generic standard item, it is deleted from all the
standard items that were linked to it in the
standards browses.
You can also reach the standards browse from
the standards tab on the update form for the
item. Press the button titled “Standard Items”
to reach it.
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The Standards Browse
The Standards Browse displays all standards
associated with an inventory item.

Whenever this browse window is entered, the
list is updated to match the entries in the
generic standards window (as long as the
entries match the categories checked).

If an item meets all the standards, the above status message appears. If it does not meet all
applicable standards, the message “At Least 1 Applicable Modeling Standard Not Met” appears.
In the above example, only the first standard “Separate Grabs” is met. The second standard,
“thin roofwalk” is not met, but the N/A (not applicable) box is checked, so the car does meet all
applicable modeling standards.

The Standards Update Window
1
2
3
4

Fields
1 Standard This text is taken from the generic standard. To change this text, you must
change the text in the generic standard record
(see the Generic Menu).

2 Meets Standard When the item meets the
standard described, you should check this box.
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3 N/A (Not Applicable) When this box is
checked, the standard item does not apply to
this car.

4 Notes - This is an optional notes area for
more fully describing the standard being
implemented.

8
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Setting Up Maintenance
The first order of business in setting up maintenance for your models is to decide what items
you wish to inspect and how often you wish to inspect them. The inspection frequency can be
entered in the “Maintenance” Tab for the car/caboose/loco (see Maintenance Tab, this chapter).

Generic Maintenance
The next thing you need to set up is your generic maintenance items. You will find these in the
Generic Menu. The purpose of the generic maintenance items are to allow you to set up a number of inspection items which all of your inventory items can be tested for.

Update Maintenance Items
The Maintenance Item Update Window contains fields that describe the inspection items
that you are setting up.
1
2
3
4
5
6

Fields
1 Text Main text stating the maintenance
item.

2 N/A (Not Applicable) When this box is
checked, the maintenance item record being
added to the inventory item will have its N/A
box checked. This means that the maintenance
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item does not apply to the car, caboose, or
locomotive. You would check this box only for
a maintenance item that you want to affect
only a minority of cars/locos/cabin cars. This
way, when a record is added to your inventory,
this item will not affect it until you uncheck
the box (on the inventory item’s maintenance
update form). Simply put, any item with the
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box checked here will by default start out not
applied to an inventory item.

3 Flag Car for Failures If the number of
failures (to pass inspection) exceeds the number in the “Flag Car at this Number of
Failures” field in the Options window (File Options), the car will be “red-flagged”, to
indicate that the car needs to be seriously
looked at.
4 Pass Indicates that the default for a new
inspection item will be for it to pass (rather
than automatically fail, which would increment the Flag).

(car, locomotive, caboose). If the box is not
checked, the maintenance item will not show up
in the inventory item’s browse window. The
difference between these checkboxes and the
N/A checkbox (item 2) is that unless these
boxes are checked, the maintenance item will
not show up at all. In the case of N/A, the item
shows up , but it is described as not applying with N/A you have a choice as to make it apply
or not from the inventory item’s maintenance
update form.

6 Notes - This is an optional notes area for
more fully describing the maintenance item
being implemented.

5 Apply to Cars, Locomotives, Caboose If a
box is checked here it means that the maintenance item will apply to the inventory type

Entering Generic Maintenance

The Maintenance Browse

1. Enter the text for the inspection item in
field number 1 above.

Each category (rolling stock, locomotives,
cabin cars) has their own maintenance
records. To see these records, you can click
on the Maintenance button that appears on
each main browse window. This activates the
maintenance browse for the current (highlighted) inventory item.

2. Check the N/A (Not Applicable) box if you
wish.
3. Check the category(s) you wish to have this
standard apply to (cars, locos, cabin cars, or
any combination, including all).
4. Use the notes field to describe techniques
used or tools required to complete the inspection.
Do this for all of the maintenance items you
wish to implement. If you have certain items
you wish to apply only to certain items, check
the N/A box. Then you can go into the
Maintenance Update window for that
car/loco/caboose and uncheck the N/A box.
You have just implemented an inspection item
that affects only that car!

When the maintenance browse is entered,
the records for that item are updated. For
example, if you had just added a new item to
the generic maintenance file, this new item (if
the matching category box had been checked)
would be added. Likewise if you delete a
generic maintenance item, it is deleted from
all the items that were linked to it in the
maintenance browses.
You can also reach the maintenance browse
from the maintenance tab on the update form
for the item. Press the button titled
“Maintenance Items”.
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The Maintenance Browse
The Maintenance Browse window displays all
maintenance items associated with an invento-

ry item. Whenever this browse window is
entered, the list is updated to match the
entries in the generic maintenance item window (as long as the entries apply).

If an inventory item passes all inspections, the above status message appears. If it fails one or
more inspection items, the message “Fails At Least 1 Applicable Item” appears. In the above
example, all items pass.
1
2
3
8
4
9
5
10
6
7

Fields

4 Failures - Counts number of failures to pass

2 Inspection Status Indicates whether item

inspection. If this item exceeds the number in
the “Flag Car at this Number of Failures” field
in the Options window (File - Options), the
car will be “red-flagged”, to indicate that the
car needs to be seriously looked at. The Clear
Failures button allows you to clear the number of failures to zero.

passes or fails inspection.

5 Successful Inspection Date This indicates

3 Pass / Fail Buttons that you press to indi-

the date of the last successful inspection. This
date is cleared when the Fail button is pressed,

1 Maintenance Item Text This text is taken
directly from the generic maintenance item. To
change this text, you must change the generic
maintenance item text (look in the Generic
Menu).

cate inspection status.
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and filled in when the Pass button is pressed.

6 Last Inspection Date - This indicates the
inspection date previous to the “Successful
Inspection Date” above.

7 Notes Optional notes concerning the
inspection item.

8 N/A (Not Applicable) When this box is
checked, the maintenance item does not apply
to this car.

9 Flag Car for Too Many Failures By
default this box is checked. When not
checked, the “red-flag” feature described in
item three above is disabled.

10 Clear Last Inspection Date This button
is used to clear the Last Inspection Date Field.
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The Maintenance Tab
The Maintenance Tab lets you update and/or
access maintenance items.

It is accessible from the Update Car Form.

1
8

2
3
4
5
6
7

Fields
1 Inspection Status Indicates whether the
inventory item passes ALL inspection items.

2 Inspection Frequency Indicates how many
days, sessions, or moves between scheduled
inspections.

3 Measure By As of this version, only Actual
Days can be used. Later on, this will be tied in
with the operational characteristics of Ship It!

4 Car Owner (Drop-down entry box) Select
or enter the owner of the car (primarily for
clubs or large home layouts where cars are
owned by different people).

5 Last Inspection Date Indicates the last
date when all of the maintenance items passed
inspection.
6 Inspected By Lists who made the inspection.
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7 Save To Buffer / Retrieve from Buffer
This allows you to copy data between the current car record and a new car record. The Save
To Buffer button saves all fields from the current car to a buffer (storage area in memory).
When you insert a new record and press the
Retrieve From Buffer record, the new car
record will be filled with the data that was
previously saved.

8 Maintenance Items This button activates
the Maintenance Browse window for the current inventory item
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Introduction
Railbase Professional allows you to display unlimited digital images of each item in the database.
Railbase Professional does not store the files in its
database, but stores the location of each file. There
is a default location for these files in the Options
window (File, Options in the pulldown menu) displayed in Figure 1 below. By pressing the Browse

button to the right of the text box, you can select a
new default path for your images. The default path
is used when you browse for images to attach to a
database item. Railbase Professional can display
the following formats: BMP, DIB, GIF, JPG, JP2,
PCX, PNG, RLE, TGA,TIF.

Figure 1
Figure 2 below shows the picture tab common to all
to preview the image full size. Once an image is disdatabase categories. The Browse for Picture button
played in the Pictures Tab, it can be panned or
allows you to search for pictures. See Figure 3 for a
zoomed. In order to zoom the image, you must have
screen shot of the picture selection window. Notice in
a thumbwheel on your mouse. To zoom, first click
the right side a thumbnail of the highlighted image.
inside the image. Then rotate the thumbwheel either
Above the thumbnail the size of the image is given in
direction. The image will zoom in or out. Panning
pixels. The icon with the magnifying glass allows you (scrolling) is also possible. To pan, click and hold the

Figure 2
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Figure 3

Figure 4
mouse button down. Then move your mouse. The
image should pan in the direction of your mouse
movement. If nothing happens, try zooming in first,
and then panning. You cannot pan an image that is at
its maximum size (there is nowhere to go!) Figure 4
shows zoomed up images from Figure 2.

boxes allow you to store other pertinent information.

The Enlarge/Edit button brings up a window similar
to Figure 5. This window is designed to fill up your
monitor. The buttons along the bottom allow you to
resize the image. Keep in mind that you can also use
the zoom and pan technique described for Figure 2.
The Data button is very important - it pulls up another
screen (see Figure 6) where you can enter in data concerning your image.
The Caption textbox in Figure 6 contains the text that
displays above each image in Figure 2. The other entry

The Clear button in Figure 2 allows you to remove
the image.

The Next Page button in the center of Figure 2
allows you to bring up another screen of images. This
function allows you to attach an unlimited number of
images to each database item.

Note: if the Next button does not become enabled
after you have filled out the first two images in the
picture tab, check your legacy flag in the Options
window (File, Options in the pulldown menu then see the Options Tab). Uncheck the Legacy
checkbox to allow yourself unlimited images per
database item.
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Figure 5

Figure 6
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Introduction
Queries are a valuable feature in Railbase
Professional. They give you the power to
search your databases for the items which are
important to you, and to save those searches.
Maybe you want to find all the brass boxcars
in your database. Maybe you want to find all
the HO cars you own that still have horn-hook
couplers on them. Or maybe you want to do a
search on prototype information, such as all
the cars that were built after 1954. The limit is
really up to you.

How To - A Short Tutorial
To start a query, press the Query button from
any browse screen (car, locomotive, or
caboose). Figure 1 displays the window that
will appear. From this window you can select
an existing query, create a new query, change
an existing query or delete a query. When you
select an existing query, the main browse
screen will list only those items that pass the
query.
Press Insert to create a new query. The window in Figure 2 will appear. This window lets
you select the items you wish to query for. In
our case, we will build a query to find all the
brass boxcars in the database. The first item
we will query for will be brass, so we need to
select the Construction field. Then press the
Next button.

Figure 1

Figure 2

The window in Figure 3 will appear. There
are a number of choices here. In our case, the
choices “Contains” or “Is Equal to” will both
work. Select “Is Equal To”, then press Next.

Figure 3
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The Query Wizard Value Entry window will
appear (Figure 4). Here you can complete the
first part of our query, completing the sentence
‘Construction Is Equal To _______. Type
Brass in the blank field to complete the sentence. Then press the Next button.

The window in Figure 5 will appear next.
This window displays all of the items that
make up your query. You can combine several
items to make up a single query, using the
AND and OR buttons. For example, you could
display all the cars that are either Plastic or
Brass by adding another query item with the
OR button. In our case, we want to display
all the brass cars with a car style of boxcar, so
we want to do an AND. AND means both
statements must be true for the car to display.
OR means either statement can be true for the
car to display. If you only wanted a single criteria query, you would press the Finish button.
Press the AND button, because we want to add
another query item.

Figure 6 displays the completed query that
appears after you build your second query
item. Build this second item the same way you
built the first query item, except choose “Car
Style - boxcar, etc.” for your item, instead of
“Construction”, and type in “boxcar” instead
of “brass”. Use “Is Equal To” like you did in
the first example. When your screen appears
just like Figure 6, press Finish.

Figure 4

Figure 5

Figure 6
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When you press Finish, the Query Wizard
asks if you wish to save this query for future
use (Figure 7). In our case we want to, so
press Yes.
The window in Figure 8 will appear, asking
you to type in a query name. Call this query
“Brass Boxcars”, and press OK.

Figure 7

Your rolling stock browse should now display
only cars with a car style of “Boxcar” with a
construction of “Brass”. See Figure 9 below.
Figure 8

You have finished your first query!

Figure 9

More Query Fun

For Ship It! Users

The entry fields in the query wizard change
according to the type of field you select. If
you build a query with a date field, such as
“Appraisal Date”, the entry field is formatted
for dates. For “Current Value”, the entry field
is formatted for currency. This makes it much
easier to build queries.

Ship It! users might want to display only those
cars “Available” for use on their layouts (or
maybe all those not available). There is an
“Available” item you can select when building
a query. The nice thing about it is you just
check a box instead of filling out a field when
building the query. Try it!
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This chapter contains some extra information on Version 2.0.
Many of the new features have been described in preceding chapters:
See page IX for information on Backup / Restore.
See page 4-3 for information on the new Browse Window.
See Chapter 9 (Displaying Images) for information on the new image functionality.
The following is a list of some of the new functionality (along with the location) that is not covered in the
above chapters or pages, along with some applicable information.

Update Form (cars, passenger cars, caboose, locos)
General Tab:
1. Prototype Only checkbox. For indicating item is not a model.

Model Tab:
1. Box Number: for indicating where the item is stored.
2. Calculate weight to add button. Use to calculate correct weight for a model, including how much
weight you need to add. (not available for locos). Note that if you enter the length of the car (in feet) in
the prototype tab, the program will calculate the model length for you in inches. But you can also enter in
the model length in inches in the Calculate Recommended Weight dialog box (this length will be converted to feet and stored in the car length field in the prototype tab. You must choose a scale for your model
for the weight calculation to work. Note: NMRA standards are used to calculate the weight.

General Category:

a picture tab has been added.

You could use the general category of the program to store any pictures that do not fall under the main
categories provided. An example would be detail or scenic images. Bridges could go under the structure
category.

Structures
In the browse, note that you can restrict the browse to show only those structures belonging to a single town. This works when you select the industry the structure belongs to in the update form. The
industry belongs to a town, so the program can limit the browse to the industries belonging to a
town. This is a Ship It! tie-in.
In the prototype tab for structures, there are entry fields for Building Type and Building Style.
Building Type is intended to indicate functionality (warehouse, factory,etc). Building Style is intended to indicate architectural style (Victorian, etc). These are not pre-set, so you can use them in any
way you see fit (or ignore them).
In the model tab, construction is meant to indicate model construction. There is also a Prototype
Only checkbox to indicate that the building is not (yet) a model. So you can collect prototype information on structures, including multiple pictures, and store this information until you build it. You
could even scan in articles or plans if you own a scanner.
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